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Figure 1. (a). Previous Retrieval Models focus on text-query retrieval exploration, neglecting the retrieval ability for other query styles.
(b). Our style-diversified retrieval setting considers the various query styles that users may prefer, including sketch, art, low-resolution,
text, and their combination, including sketch+text, art+text, etc. Our model makes fine-grained retrieval based on the shape, color, and
pose features from style-diversified query inputs. (c). The performance comparison between our model and other retrieval baselines.

Abstract

Image Retrieval aims to retrieve corresponding images
based on a given query. In application scenarios, users in-
tend to express their retrieval intent through various query
styles. However, current retrieval tasks predominantly focus
on text-query retrieval exploration, leading to limited re-
trieval query options and potential ambiguity or bias in user
intention. In this paper, we propose the Style-Diversified
Query-Based Image Retrieval task, which enables retrieval
based on various query styles. To facilitate the novel setting,
we propose the first Diverse-Style Retrieval dataset, en-
compassing diverse query styles including text, sketch, low-
resolution, and art. We also propose a light-weighted style-
diversified retrieval framework. For various query style
inputs, we apply the Gram Matrix to extract the query’s
textural features and cluster them into a style space with
style-specific bases. Then we employ the style-init prompt
tuning module to enable the visual encoder to comprehend

the texture and style information of the query. Experiments
demonstrate that our model, employing the style-init prompt
tuning strategy, outperforms existing retrieval models on the
style-diversified retrieval task. Moreover, style-diversified
queries (sketch+text, art+text, etc) can be simultaneously
retrieved in our model. The auxiliary information from
other queries enhances the retrieval performance within
the respective query1. The code is available in https:
//github.com/CuriseJia/FreeStyleRet.

1. Introduction
Query-based image retrieval (QBIR) [50] refers to the task
of retrieving relevant images from a large image database
based on the user’s query or search term. QBIR has numer-
ous applications, ranging from image search engines [21]
to cross-modality downstream tasks [30, 31]. It plays a cru-

1∗ Equal Contribution, † Corresponding Author. We have included the
code and dataset in the supplementary material.
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Figure 2. The Diverse-Style Retrieval Dataset (DSR). We propose the Diverse-Style Retrieval dataset, containing 10,000 natural images
and their corresponding queries with various styles, including Sketch, Art, Low-Resolution (Low-Res), and Text. The Diverse-Style
Retrieval dataset is the first dataset for the style-diversified query-based image retrieval task.

cial role in enabling users to locate and obtain related visual
content based on their retrieval intent.

The diversification of user retrieval intents poses a signif-
icant and unresolved problem in QBIR [34]. Selecting ap-
propriate queries to express user intents and enabling mod-
els to accommodate diverse query styles are crucial chal-
lenges. However, the current exploration in the field of
QBIR has primarily focused on text-image retrieval [33, 42]
and text-video retrieval [23, 24], with less emphasis on other
query types [25]. To address the issue of limited query
style adaptability in current retrieval models, we propose
a novel setting: Style-diversified Query-based Image Re-
trieval in Fig. 1(b). The objective of this setting is to en-
able retrieval models to simultaneously accommodate vari-
ous query styles, aiming to bridge the user intent gap caused
by the lack of query adaptation versatility.

We propose the Diverse-Style Retrieval dataset (DSR)
as the evaluation dataset of our style-diversified QBIR task.
As shown in Fig. 2, the dataset contains 10,000 natural im-
ages and four corresponding query styles: text, sketch, low-
resolution, and art. (i). Text: the text-form query to describe
the retrieval intent. (ii). Sketch: hand-drawn sketch by users
to provide shape and pose features. (iii). Low-Res: users
capture regions of interest from images and convert them
into low-resolution images to serve as queries. (iv). Art:
artistic-style images as retrieval queries.

We further propose a lightweight Plug-and-Play frame-
work, FreestyleRet, for the style-diversified retrieval task.
For query inputs with different styles, we borrow the idea
from image style transfer, calculating each query’s Gram
Matrix [2, 36] as the query’s style representation, due to
the Gram Matrix’s ability to capture the textural informa-
tion and spatial relationships between channels in the input
image. Then, we construct the high-dimensional style space
by clustering all-style queries’ gram matrices and taking the
clustering centers as the style basis in the style space. With
the well-constructed style space, we introduce the applica-

tion of a style-init prompt tuning module on a frozen vi-
sual encoder [33, 42], thereby enabling the encoder to adapt
to various-style queries in a cost-effective manner. Specif-
ically, given a query input, we employ its corresponding
Gram matrix in conjunction with the weighted projections
within the style space onto the diverse style basis as the ini-
tialization mechanism for prompt tokens in the prompt tun-
ing procedure. Finally, we use the query feature from the
visual encoder for further retrieval.

The proposed framework has three compelling advan-
tages: First, The style-space construction and the style-init
prompt tuning strategy enable the framework to adapt to
various query styles. Experimental results on two bench-
mark datasets demonstrate the advantages of our model in
Fig. 1(c). Second, Our framework is compatible with the re-
trieval of multiple query types simultaneously, thereby pro-
moting the single-query retrieval performance. Third, the
prompt-tuning structure lowers the computation cost and
achieves plug-and-play abilities on various pre-trained vi-
sual encoders. The main contributions are as follows:
• We are the first to propose the style-diversified QBIR task

and its corresponding dataset, DSR, to address the users’
intent gap problem in retrieval applications.

• Our framework is lightweight and plug-and-play. With
the style space construction module and the style-init
prompt tuning module, our framework achieves excellent
performance when retrieving style-diversified queries.

• More encouragingly, the style-diversified queries can be
simultaneously retrieved in our framework and mutually
enhance each other’s performance, which may have a far-
reaching impact on the retrieval community.

2. Related Works

Query-based Image Retrieval. Query-based Image Re-
trieval (QBIR) [50] aims to retrieve relevant images from
a large database based on a given query. In QBIR, the
query can take different forms. The earliest query form is



images including natural-image retrieval [10] and face re-
trieval [26]. With the development of cross-modal repre-
sentation learning, text-style query tasks are extensively in-
vestigated, including text-image retrieval [33, 42] and text-
video retrieval [23, 24]. Limited research incorporates other
query styles such as sketch [8, 9] and scene graph [25]. In
Fig. 1(b), to address the issue of single query modality be-
ing insufficient to express user search intent, we propose the
style-diversified query-based image retrieval task, retrieving
text, sketch, art, and low-resolution queries simultaneously.
Promp Tuning. The objective of Prompt Tuning [29, 35]
is to enhance the transferability of pre-trained models to
downstream tasks in a cost-effective manner by incorpo-
rating learnable tokens into the fixed pre-trained models.
Prompt Tuning was first proposed as text-prompt [3, 38]
in the language model and gained popularity in 2D [61]
and 3D [58] image models. Specifically, CLIP [42] ap-
plies fixed class-specific text as prompts. Then, CoOP [62]
learns class-specific continuous prompts. VPT [22] first ap-
plies continuous prompt tokens to vision pre-trained mod-
els. Inspired by VPT, we establish a style-init prompt tuning
framework for the style-diversified QBIR task.
Image Style Transfer. Image style transfer [4, 37, 59]
involves the transformation of an input image to adopt the
artistic style or visual characteristics of a reference image
while preserving its content. Early approaches [13, 14, 28]
in image style transfer are optimization-based methods re-
lying on handcrafted features focusing only on low-level
image features. With the advent of deep learning, CNN
and GAN models [27, 43] can extract high-level seman-
tic features to facilitate the high-level image synthesis [15].
For style transfer models, the Gram Matrix plays a crucial
role in providing the representation of the textural and style
information present in an image [2, 36]. We borrow the
Gram Matrix for our style-diversified QBIR task, applying
the Gram Matrix feature as the prompt token initialization
when prompt tuning the visual encoder.

3. Preliminary of Style-Diversified QBIR

In this section, we first introduce the problem setting of the
Diverse-style Query-based Image Retrieval task in Sec.3.1,
then introduce the new dataset we propose for this new re-
trieval setting in Sec.3.2.

3.1. Problem Setting of Style-Diversified QBIR

Given a gallery of natural images NI and a query qi from
the style-specific query set Qs. The goal for query-based
image retrieval is to rank all images i ∈ NI so that the
image corresponding to the query qi is ranked as high as
possible. For our style-diversified QBIR setting, the goal is
similar, ranking all images correctly with queries for various
style-specific query sets {Qs}ns=1.

3.2. Datasets Construction

In the context of Style-diversified Query-based Image Re-
trieval, we adopt two datasets as evaluation metrics: the
Diverse-Style Retrieval dataset (DSR) and ImageNet-X.
Diverse-Style Retrieval Dataset: A small but fine-grained
dataset constructed for style-diversified QBIR. Shown in
Fig. 2, it consists of 10,000 natural images paired with cor-
responding queries of four styles: text, sketch, low-res, and
art. (i). Text: the text query used to express the retrieval
intent. (ii). Sketch: hand-drawn sketch by users to provide
shape and pose features. (iii). Low-Res: users capture re-
gions of interest from images and convert them into low-
resolution images to serve as queries. (iv). Art: artistic-style
images as queries. With the rise of the AIGC [5, 54, 57],
generating images of different styles has become more con-
venient. Therefore, based on ten thousand natural images
from FSCOCO [8], we utilize AnimateDiff [18] to gener-
ate corresponding artistic style images. We employ down-
sampling algorithms to generate low-resolution images. As
FSCOCO provides sketch images, we use Pidinet [46] to
optimize low-quality sketch images.
ImageNet-X: A large but coarse-grained dataset for style-
diversified QBIR. Based on ImageNet [11], ImageNet-X
contains 1M natural images and their corresponding sketch-
form and art-form versions. Compared to DSR, the images
in ImageNet-X are simple, containing only one object. We
generate the low-resolution form for images and reconstruct
ImageNet-X as the dataset for style-diversified QBIR.

4. Methodology
Our model consists of three main submodules: (1) a Gram-
based Style Extraction Module for generating the gram
matrix of an input query, representing the query’s textural
feature (Sec.4.1). (2) a Style Space Construction Module
for building up the query style space by clustering queries’
gram matrices and taking the cluster centers as the style ba-
sis (Sec.4.2). (3) a Style-Init Prompt Tuning Module for
style-specific prompt tuning a pre-trained visual encoder by
initializing the prompt tokens based on the gram matrices
and the style prototypes (Sec.4.3). The overview framework
of our FreestyleRet is illustrated in Figure 3.

4.1. Gram-based Style Extraction Module

For query inputs with diverse styles, the gram-based style
extraction module aims to generate the style representation
from the input query. Here we borrow the style represen-
tation strategy from image style transfer, taking the gram
matrix of the query’s feature as the style representation.

First, we apply the frozen VGG model [45] to get the
query’s visual feature. Compared with other image fea-
ture extractors including ViT [12] and ResNet [20], VGG
is lightweight and has strong feature extraction ability dur-
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Figure 3. The Overall Framework of our FreestyleRet. For a style-diversified query input, we first extract the query’s textural feature
by calculating the query’s gram matrix from the Gram-based Style Extraction Module. Then we construct the style space of queries by
clustering all gram matrices and taking each clustering center as the style basis in style space. We further extract the query’s style feature
by weighted summarizing style bases based on the distance between the input query and every style basis in the style space. Finally, in the
Style-Init Prompt Tuning Module, we use the gram matrix and the style feature to initialize prompt tokens, leading both textural and style
information to the feature encoder for further style-diversified retrieval prediction.

ing the gram matrix calculation in image style transfer
works [49, 53]. The VGG model is constituted by a con-
catenation of 16 layers, consisting of stacked convolutional
and fully connected layers, meticulously structured to cap-
ture complex patterns in the visual data. For query input
qi, we use the third convolutional layer output, shaping
112 × 112 × 128, as the visual feature vi of the query qi.
fd(.) is used to downsample vi.

Then, we calculate the gram matrix for query qi. Specif-
ically, the Gram Matrix g of a set of vectors t1, ..., tn in an
inner product space is the Hermitian matrix of inner prod-
ucts: gjk =< tj , tk >. g represents the texture feature of
vectors t1, ..., tn. In our scenario, we calculate the gram
matrix gi for qi as follows:

gi = (fd(vi))
Tfd(vi), (1)

where gi represents the textural feature of the query qi.

4.2. Style Space Construction Module

For style-diversified query inputs, we construct the style
space S for queries to encode their specific styles. To gener-
ate the style-specific basis B = {bj}4j=1 for the style space,
we cluster the gram matrices of all queries in various styles
and apply each clustering center as the style-specific basis
bj for the style space B.

During the clustering procedure, we apply the K-Means
algorithm to cluster the gram matrix set G for all queries
from query sets in the dataset, where G = {gi},∀qi ∈ Qs.
We first random initialize four clustering centers µ1, ..., µ4
as the basis of the style space. Then we calculate the nearest
center ci comparing each gram matrix gi ∈ G with existing

clustering centers:

ci = argmax
j

||gi − µj ||2, (2)

where j = 1, ..., 4. We redistribute all queries to their near-
est center based on the ci. Then we refine the position of µj

by averaging all queries belong to µj :

µj =

∑m
i=1 Num{ci = j} × gi∑m

i=1 Num{ci = j}
, (3)

We repeat the iteration of Eq.2 and Eq.3 until the cluster-
ing centers’ positions converge. The well-trained cluster-
ing centers µ1, ..., µ4 act as the style-specific basis for the
constructed style space. We further use these style-specific
bases to represent the style feature si of an input query qi.
Specifically, the style feature si is calculated by weighted
summarizing all the style bases according to the cosine sim-
ilarity w between qi and µj ,∀j ∈ [1, 4].

wj =
ecos(qi,µj)∑4
j=1 e

cos(qi,µj)
, si =

4∑
j=1

wjµj , (4)

The weighted summarizing calculation enables the model
to generate the qi’s style feature adaptively.

4.3. Style-Init Prompt Tuning Module

To build up a lightweight and plug-and-play framework, we
apply the prompt tuning procedure on a frozen pre-trained
visual encoder to make the frozen visual encoder under-
stand the various-style query inputs. As shown in Fig. 3,
during the prompt tuning, we insert four trainable prompt
tokens into both the shallow layer and the bottom layer of



# Method
Text → Image Sketch → Image Art → Image Low-Res → Image

R@1↑ R@5↑ R@1↑ R@5↑ R@1↑ R@5↑ R@1↑ R@5↑

Diverse-Style Retrieval Dataset

1 CLIP ICML2021 [42] 66.1 94.7 47.5 77.3 58.5 93.7 45.0 75.7

2 CLIP∗ ICML2021 [42] 72.2 96.4 63.6 93.6 58.2 90.4 78.8 97.1

3 BLIP∗ ICML2022 [33] 74.3 95.3 67.1 90.9 51.1 85.3 77.2 95.8

4 VPT∗ ECCV2022 [22] 69.9 96.1 73.3 97.0 66.7 96.5 81.4 96.0

5 ImageBind CVPR2023 [16] 71.0 95.5 50.8 79.4 58.2 86.3 79.0 96.7

6 LanguageBind Arxiv2023 [63] 79.7 98.1 63.6 89.1 67.5 92.9 78.6 94.5

7 FreestyleRet-CLIP 69.9 97.0 80.6 97.4 71.4 97.8 86.4 97.9

8 FreestyleRet-BLIP 81.6 99.2 81.2 97.1 74.5 97.4 90.5 98.5

ImageNet-X Dataset [11]

9 CLIP∗ ICML2021 [42] 42.6 72.7 41.3 73.9 38.5 65.3 74.1 95.7

10 BLIP∗ ICML2022 [33] 63.9 90.7 53.6 88.1 49.6 84.8 89.5 97.8

11 VPT∗ ECCV2022 [22] 43.3 85.3 48.6 84.2 41.6 88.5 72.7 89.3

12 ImageBind CVPR2023 [16] 57.3 89.7 53.6 86.2 49.8 79.3 81.2 94.3

13 LanguageBind Arxiv2023 [63] 68.9 92.3 62.0 91.5 60.3 89.9 87.4 99.5

14 FreestyleRet-CLIP 62.6 94.3 57.4 88.2 56.4 90.2 69.4 94.5

15 FreestyleRet-BLIP 74.9 96.3 74.6 93.3 71.2 96.5 97.5 99.7

Table 1. Retrieval performance for Style-Diversified QBIR task. We evaluate the R@1 and R@5 metrics on two benchmark datasets,
the Diverse-Style Retrieval dataset and the ImageNet-X dataset. “↑” denotes that higher is better. The two forms of our FreestyleRet
framework, FreestyleRet-CLIP and FreestyleRet-BLIP, outperform in multiple scenarios with different query styles compared with other
baselines including cross-modality models (CLIP, BLIP, VPT) and multimodality models (ImageBind, LanguageBind).

the vision transformer encoder, to tune the visual encoder
comprehensively. The prompt tokens are introduced to ev-
ery transformer layer’s input space. For i-th Layer Li in
the transformer, we denote the collection of input learnable
prompts Pi as

Pi = {pki ∈ Rd|k ∈ N, 1 ≤ k ≤ m}, (5)

where d = 1024 represents the token dimension in the
transformer layer. m = 4 represents the prompt token num-
ber for each transformer layer. The style-init prompt tuning
module for ViT is formulated as follows:

[xi, , Ei] = Li(xi−1, Pi−1, Ei−1), i = 1, ..., n (6)
fi = Head(xn), (7)

where n represents the transformer layer number, xi repre-
sents the [CLS]’s embedding at Li’s input space, Ei is qi’s
image patch embeddings. Head represents the MLP to gen-
erate visual feature fi using the [CLS] embedding of qi.

To further lead the style information to the visual en-
coder, given an input query qi, we initialize the prompt to-
kens in the shallow layer based on the gram matrix from
Eq.1 and initialize the tokens in the deep layer based on the
style feature si calculated from Eq.4. Further experimental
analysis in Table. 5 shows that differentiated style initializa-

tion across different layers can boost the performance of the
ViT-based visual encoder.

4.4. Training and Inference

As shown in Fig. 3, our FreestyleRet iterates the dataset
twice during the training process. We first construct the
style space during the first iteration. Then we apply the
well-constructed style space for style-init prompt tuning
during the second iteration. The overall loss L of our model
is the triplet loss:

dist(x, y) = 1− cos(x, y), (8)

L =
1

B

B∑
i=1

(max(0,dist(Fi, Pi)− dist(Fi, Ni) + α))

(9)

where F represent the image features F = {fi}n1 . P rep-
resents the positive samples and N represents the negative
samples. During the training, we take the ground-truth re-
trieval answer as P . For N we randomly select another
image from the same query-style set as qi. We set the hy-
perparameter α to 1.0.

Our inference process iterates the test dataset once, us-
ing the gram-based style extraction module and the well-
constructed style space to get the textural feature from the



# Method
Sketch Art Low-Resolution

Text→Image Sketch+Text→Image Text→Image Art+Text→Image Text→Image Low-Res+Text→Image

1 CLIP∗ 72.2 65.0(−7.2) 72.2 57.8(−14.4) 72.2 84.7(+12.5)

2 BLIP∗ 74.3 74.2(−0.1) 74.3 58.3(−16.0) 74.3 88.3(+14.0)

3 FreestyleRet 69.9 82.5(+12.6) 69.9 76.6(+6.7) 69.9 86.7(+16.8)

Table 2. Retrieval performance with multi-style queries simultaneously. The additional query inputs (sketch, art, low-res) can boost
the text-image retrieval capability in our FreestyleRet while showing a negative influence on baseline models, including CLIP and BLIP.

# Shallow Bottom Token-Num Sketch→I Art→I Low-Res→I

1 Random Random 4 68.1 63.5 78.8

2 Style Space Random 4 76.7 69.1 82.4

3 Random Gram 4 76.8 69.2 81.8

4 Gram Style Space 4 78.1 69.5 84.4

5 Style Space Gram 4 80.6 71.4 86.4

6 Style Space Gram 1 68.2 64.7 79.1

7 Style Space Gram 2 72.3 65.9 82.8

8 Style Space Gram 8 77.9 67.1 80.7

Table 3. The analysis for the prompt token design. We ablate the prompt tokens’ num-
ber, insert position, and initialization feature in our FreestyleRet framework.
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Figure 4. The prompt tuning structure in
the Freestyle framework.

gram matrix and style feature for the input query. Then we
apply the style-init prompt tuning module for retrieval.

5. Experiments
5.1. Experimental Settings

For the experiments on the DSR and the ImageNet-X
datasets, FreestyleRet is trained on one A100 GPU with
batch size 24 and 20 training epochs. The learning rate is
set to 1e-5 and is linearly warmed up in the first epochs and
then decayed by the cosine learning rate schedule. During
training, all input images are resized into 224× 224 resolu-
tion and then augmented by normalized operation.

5.2. Main Results

we select the most recent multi-modality pre-trained models
for comparison, including three cross-modality pre-trained
models (CLIP, BLIP, VPT) and two multi-modality pre-
trained models (ImageBind, LanguageBind). Specifically,
we prompt-tuning the cross-modality models to adapt style-
diversified inputs. * represents the prompt-tuning version
of the vanilla models. As for the multi-modality pre-
trained models, we evaluate the zero-shot performance on
the sty-diversified retrieval task due to multi-modality mod-
els’ comprehensionability on multi-style image inputs. We
apply two benchmark datasets, including the ImageNet-X
and the DSR dataset, for our style-diversified retrieval task.
The results in Table. 1 yield three observations:

(i). Cross-modality and Multi-modality models have
the potential for improvement in the style-diversified re-
trieval task. Line.1 in Tab. 1 shows that zero-shot CLIP
performs badly compared with our FreestyleRet. This lim-
itation arises from the inability of vision-linguistic mod-
els like CLIP to distinguish visual inputs with different
styles from those of natural images in the feature space.
With the prompt tuning process, cross-modality models
have significant improvements, as shown in line.2-4 and
line.9-11. As for the multi-modality models, ImageBind
and LanguageBind, line.5-6 and line.12-13 show that multi-
modality models have style-diversified retrieval abilities.

(ii). The CLIP-form and Blip-form models of our
FreestyleRet framework outperform both cross-modality
and multi-modality models. Claimed in Sec.4.3, our
FreestyleRet is a plug-and-play framework that can eas-
ily applied to various pretrained visual encoders. Here
we apply our FreestyleRet on two ViT-based visual en-
coders from CLIP and BLIP. We use FreestyleRet-CLIP
and FreestyleRet-BLIP as the generated models. Line.7-8
and line.14-15 in Tab. 1 show that both FreestyleRet-CLIP
and FreestyleRet-BLIP outperform the cross-modality and
multi-modality baselines, demonstrating the effectiveness
of our plug-and-play framework.

(iii). In our FreestyleRet framework, style-diversified
queries can be simultaneously retrieved and mutually en-
hance the text-image retrieval performance. As shown
in Tab. 2, when conducting text-image retrieval, the addi-
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Figure 5. The Feature Distribution Analysis for our FreestyleRet. We make t-SNE [51] visualization for the middle layer L12 and the
output layer L24 from the FreestyleRet and the CLIP baseline. The colorful dots donate query features, different colors represent different
semantics. Compared to the baseline, FreestyleRet achieves better semantic clustering at both middle and deep layers.

Method Parameters(M) Speed(ms)

CLIP ICML2021 [42] 427M 68ms

BLIP ICML2022 [33] 891M 62ms

VPT ECCV2022 [22] 428M 73ms

ImageBind CVPR2023 [22] 1200M 372ms

FreestyleRet-CLIP 476M(+29) 96ms(+28)

FreestyleRet-BLIP 940M(+29) 101ms(+39)

Table 4. Comparison of the computation complexity between our
FreestyleRet and baselines. Our framework is computationally ef-
ficient from the trainable parameter and inference speed aspects.

tional query inputs (sketch, art, low-res) can significantly
boost the text-image retrieval capability of our FreestyleRet
framework. However, for baseline models, the additional
query signals cannot stably improve the text-image retrieval
performance. In line.1-2 in Tab. 2 the additional sketch and
art queries have a negative effect on the CLIP and BLIP.

5.3. Ablation Studies

In this section, we ablate the detailed performance analysis
and the model design choices of our FreestyleRet frame-
work. The details are as follows.

5.3.1 Ablation for Prompt Tuning Structure

We ablate the prompt tuning structure in our FreestyleRet
framework from three aspects: the prompt token initializa-
tion feature, the position where the prompt tokens are in-
serted, and the prompt token number. Table. 5 shows the
ablation results. Furthermore, Fig. 4 proposes the detailed
structure of the prompt tuning module in FreestyleRet.

The prompt token position. Previous prompt tun-
ing models [22, 38, 39] analyzed that inserting the learn-
able prompt tokens in all layers in the transformer (Deep
Prompt) has better performance than in the first layer in the
transformer (Shallow Prompt). In the prompt tuning mod-
ule of our FreestyleRet, we also adopt the deep prompt idea
and insert all the learnable prompt tokens into all layers.

The prompt token initialization. We analyze the im-
pact of the prompt token initialization by applying differ-
ent initialization strategies in different positions of the vi-
sual encoder. Line.1-5 in Table. 5 show the ablation results,
where “Random” represents random initialization, “Gram”
represents initializing with textual information from the
gram matrix, and “Style Space” represents initializing with
style information from the style space feature. The random
initialization in line.1 performs worst, demonstrating that
applying textural and style representation as initialization is
necessary. We make various initialization attempts in line.2-
4 and find that initializing the shallow-layer prompt tokens
with style features, while initializing the deep-layer prompt
tokens with gram matrices, achieves the best performance.

The prompt token number. We make ablation studies
for the number of prompt tokens that are inserted into the
visual encoder during the prompt tuning stage. As shown in
line.5-8 in Table. 5, our FreestyleRet framework, adopting
4 prompt tokens, outperforms other number settings includ-
ing 1, 2, 8 prompt tokens under three evaluation metrics.

5.3.2 Computation Comparison

To validate the lightweight nature of our FreestyleRet
framework and its ease of integration into existing retrieval
models, we analyze the computational complexity of our
framework compared with other baselines. Table. 4 shows
the statistical analysis of trainable parameters and inference
time per batch for our FreestyleRet framework and other
baselines. Compared with the multi-modality model, Im-
ageBind, our FreestyleRet is lightweight both in the train-
able parameter and the inference speed. Compared with
the cross-modality models, including CLIP and BLIP, our
framework slightly increases the inference time and the
trainable parameter while maintaining rapid deployment
and application without significant impact.

5.4. Qualitative Analysis

In this section, we do the qualitative analysis of our frame-
work’s performance by visualizing the high-dimensional
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Figure 6. The Case Study for our FreestyleRet and the CLIP baseline. We visualize style-diversified queries and their corresponding
retrieval answers from our FreestyleRet model and the baseline model. We summarize three common retrieval errors: pose errors, category
errors, and color errors. Our FreestyleRet is capable of effectively retrieving based on specific pose, category, and color information from
sketch, art, and low-resolution queries. However, the CLIP baseline model tends to encounter errors in these cases.

feature distribution and the prediction cases from our
FreestyleRet framework compared with the baseline, the
prompt tuning form of the CLIP model.

5.4.1 Feature Distribution Analysis

In Fig.5, we analyze the feature distribution using t-
SNE [51] visualizations for the middle layer L12 features
and the output layer L24 features from our FreestyleRet and
the prompt-tuning CLIP as the baseline. The colorful dots
donate style-diversified query features, different colors rep-
resent different semantic classes, including dog, cat, truck,
etc. Comparing Fig. 5 (d) with Fig. 5 (b), our FreestyleRet
can successfully cluster together different style queries with
similar semantic classes, while the baseline cannot achieve
semantic clustering. Comparing Fig. 5 (c) with Fig. 5 (a),
in the middle layer, our FreestyleRet has already clustered
similar semantic queries, while the baseline cannot under-
stand the semantic feature from style-diversified queries,
showing random cluster in high-dimensional space.

5.4.2 Case Study and Error Analysis

In Fig. 6, we visualize the style-diversified query inputs and
their corresponding retrieval answers from our FreestyleRet
model and the CLIP baseline model. We summarize three

common retrieval errors in the case analysis, where pose er-
rors, category errors, and color errors represent the false re-
trieval result with false poses, categories, and colors. We
propose the pose error cases in Fig. 6(a). The pose in-
formation is contained widely in different style queries.
Thus, pose error cases occur in sketch, art, low-res queries.
The art queries tend to reshape the category into the art
form. Thus, in Fig. 6(b), most of the category errors oc-
cur in the art-style retrieval task. For the low-resolution
query retrieval task, color is vital retrieval information. In
Fig. 6(c), we show the color errors from the low-resolution
retrieval task. Compared with the CLIP baseline model, our
FreestyleRet framework can achieve fine-grained retrieval
based on the pose, category, and color information from
style-diversified query inputs, demonstrating the superior-
ity of our FreestyleRet framework.

6. Conclusion
In this paper, we are the first to propose the style-diversified
query-based image retrieval task to address the issue of
limited query style adaptability in current retrieval mod-
els. We construct a corresponding dataset, the Diverse-
Style Retrieval dataset, for the style-diversified QBIR task.
We further propose a lightweight plug-and-play framework,
FreestyleRet, to retrieve from style-diversified query inputs.
Our FreestyleRet extracts the query’s textural and style fea-



tures from the gram matrix as the style-diversified initializa-
tion for the prompt tuning stage. This facilitates the frame-
work in adapting to style-diversified query-based image re-
trieval. Experiment results show the effectiveness and com-
putational efficiency of our FreestyleRet. In future work,
we will incorporate a broader range of query styles into our
Diversified-Style Dataset and explore more efficient style-
based prompt-tuning strategies for our framework.
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# Shallow Bottom S→I A→I LR→I

1 Random - 78.1 70.2 85.3

2 Style Space - 78.5 71.6 85.5

3 Gram Matrix - 79.0 70.9 84.2

4 - Random 78.5 70.3 83.5

5 - Style Space 79.4 70.7 84.7

6 - Gram Matrix 79.2 70.8 83.8

7 Style Space Gram 80.6 71.4 86.4

Table 5. The ablation analysis for the prompt token inserting
strategy. We ablate three prompt-token inserting strategies in our
FreestyleRet framework, including inserting in the shallow layer,
inserting in the deep layer, and inserting in both layers. Experi-
ments show that inserting in both shallow and deep layers achieves
the best performance.

7. Supplements for Experimental Results

We present the supplementary experiments for style-
diversified retrieval results and the ablation studies for our
FreestyleRet framework.

7.1. Extra Ablation for Prompt Token Inserting
Strategies

In the main paper, we conducted ablation experiments on
the initialization choices and the number of prompt-tuning
tokens in the prompt-tuning structure. In the supplementary
material, we further performed ablation on the number of
layers in the prompt tuning structure. Specifically, in Ta-
ble. 5, we compared the performance of the model when
only inserting prompt tokens in shallow layers, only insert-
ing prompt tokens in deep layers, and inserting prompt to-
kens in both shallow and deep layers. All experiments in
Table. 5 are conducted by our FreestyleRet framework on
the DSR dataset. “S→I” represents sketch to image re-
trieval. “A→I” represents art to image retrieval. “LR→I”
represents low-resolution to image retrieval.

Compare line.7 with line.1-3 and line.4-6 in Table. 5, in-
serting prompt tokens in both shallow and deep layers out-
performs other inserting strategies. In comparison to the
random initialization method (line.1&4), both style initial-
ization (line.2&5) and gram initialization (line.3&6) result
in higher accuracy. Additionally, the deep-layer prompt
provides the encoder with a larger bias, contributing to a
slight increase in performance compared to the shallow-
layer prompt strategy.

Figure 7. The epoch analysis for our FreestyleRet framework.
For style-diversified retrieval tasks, our lightweight framework
achieves a rather good performance under 10 epochs.

7.2. Epoch Analysis for the FreestyleRet

To demonstrate the fast convergence and low computational
cost of our FreestyleRet framework, we conduct the epoch
analysis for our FreestyleRet and visualize the performance
change under different epochs training.

As shown in Fig.7, our FreestyleRet framework achieves
better performance and faster convergence speed with 5-
10 training epochs compared to other baselines such as
prompting tuning BLIP, CLIP, and VPT models. These pre-
trained baseline models need at least 50 or more training
epochs to converge.

Also, we observe that text and low-resolution retrieval
converge after 5 training epochs, faster than art and sketch
retrieval (10 epochs). The text modal and the low-resolution
style have less information gap between the natural image
modality, so their performance converges faster. On the
other hand, the sketch style and the art style, containing
more style and textural information, require more epochs
(about 10) to achieve better retrieval accuracy. Additionally,
each training epoch only takes 4 minutes. The performance
in the main body is an average of epoch-5, epoch-10, and
epoch-20 evaluation results.

7.3. More Experimental Results for the Style-
Diversified Retrieval Task

In order to comprehensively validate the superiority of our
FreestyleRet model in handling the retrieval of queries
with different styles, we conducted extensive experi-
ments involving cross-modal retrieval among various style-
diversified queries, including any queries to Text modality,
any queries to Art modality, any queries to Sketch modality,
and any queries to Low-resolution modality.

We present the performance comparison between our



# Method
Image→Text Sketch→Text Art→Text Low-Res→Text

R@1 R@5 R@1 R@5 R@1 R@5 R@1 R@5

1 CLIP∗ 55.2 90.8 48.4 87.9 64.5 96.8 42.6 81.8

2 BLIP∗ 71.4 94.9 55.5 87.0 81.0 98.8 49.2 81.8

3 VPT 52.2 91.7 45.2 87.7 52.7 94.6 44.3 84.6

4 ImageBind 73.5 96.5 56.1 88.4 82.7 99.0 42.4 73.8

5 LanguageBind 80.5 98.3 63.9 91.6 87.2 99.7 56.9 86.8

6 FreestyleRet-CLIP 71.6 98.0 66.7 96.7 74.4 99.1 64.1 94.8

7 FreestyleRet-BLIP 82.8 99.0 71.0 96.4 86.6 99.7 69.5 96.9

Table 6. The Text-Retrieval performance of our FreestyleRet and baseline models.

# Method
Image→Art Sketch→Art Text→Art Low-Res→Art

R@1 R@5 R@1 R@5 R@1 R@5 R@1 R@5

1 CLIP∗ 63.0 94.7 61.2 92.7 75.5 98.2 51.9 87.9

2 BLIP∗ 57.1 88.5 44.8 82.8 82.8 98.7 39.4 79.3

3 VPT 67.4 95.5 60.3 93.1 61.6 96.5 44.3 84.6

4 ImageBind 46.4 80.5 28.7 60.8 82.6 98.9 57.8 89.6

5 LanguageBind 65.8 93.2 41.1 77.7 86.7 99.2 34.8 72.0

6 FreestyleRet-CLIP 72.9 97.8 66.5 96.2 85.0 99.6 62.8 94.1
7 FreestyleRet-BLIP 73.6 97.4 63.1 94.4 90.2 99.7 60.1 92.2

Table 7. The Art-Retrieval performance of our FreestyleRet and baseline models.

FreestyleRet and other baselines in Table. 6 (Any→Text),
Table. 7 (Any→Art), Table. 8 (Any→Sketch), and Ta-
ble. 9 (Any→Low-resolution Images). All experiments
are conducted on the DSR dataset. Experimental re-
sults demonstrate that our FreestyleRet framework achieves
state-of-the-art (SOTA) performance in almost all retrieval
scenarios. Specifically, in complex scenarios including
sketch and art style retrieval, our FreestyleRet model out-
performs other baseline models by a significant margin of
6%-10% due to the integration of our style extraction mod-
ule and style-based prompt tuning module.

In Table. 9, we observed that the fine-tuned BLIP model
outperforms our FreestyleRet model in the retrieval of Im-
ages to low-resolution images. This is because there is
a high semantic similarity between low-resolution images
and natural images, and simple prompt tuning allows the
baseline model to achieve good results. However, our
model still surpasses the baseline in tasks involving cross-
modal retrieval from other modalities to low-resolution im-
age modalities.

8. Comparison with Other Retrieval Settings

Our FreestyleRet proposes a novel retrieval setting: Image
Retrieval with Style-Diversified Queries. However, dur-

ing our survey of related works, we have identified sev-
eral closely related retrieval tasks, including Composed Im-
age Retrieval [52], User Generalized Image Retrieval [41],
Fashion Retrieval [19], Synthesis Image Retrieval [52], and
Sketch Retrieval [55]. Consequently, we summarize these
tasks and highlight the differences and contributions of our
novel task: Style-Diversified Image Retrieval Task in com-
parison to them.

8.1. Composed Image Retrieval

Introduction: Composed Image Retrieval (CIR) [40, 52]
aims to retrieve a target image based on a query composed
of a reference image and a relative caption that describes
the difference between the two images. Zero-shot CIR [1]
is a derivative task associated with CIR, learning image-text
joint features without requiring a labeled training dataset.
The CIR task has been extensively studied in various Vision
and Language tasks, such as visual question answering [32,
56] and visual grounding [6, 7].

Difference: The composed image retrieval focuses on
retrieving natural images from composed queries (im-
age+text) and does not consider style-diversified query in-
puts. However, our style-diversified retrieval setting not
only achieves style-diversified query-based retrieval ability



# Method
Image→Sketch Art→Sketch Text→Sketch Low-Res→Sketch

R@1 R@5 R@1 R@5 R@1 R@5 R@1 R@5

1 CLIP∗ 70.5 96.1 60.5 92.9 55.0 90.8 60.4 90.9

2 BLIP∗ 69.8 93.5 47.6 82.8 58.6 89.8 52.3 82.8

3 VPT 71.7 96.2 62.3 92.9 49.4 88.6 63.3 91.5

4 ImageBind 54.0 81.8 38.3 71.6 56.1 88.4 26.2 52.5

5 LanguageBind 74.6 96.1 57.5 87.0 65.7 94.0 54.5 83.8

6 FreestyleRet-CLIP 77.8 98.1 66.5 96.2 72.3 97.4 68.7 95.1
7 FreestyleRet-BLIP 80.5 97.7 66.8 94.9 76.6 97.7 71.1 94.3

Table 8. The Sketch-Retrieval performance of our FreestyleRet and baseline models.

# Method
Image→Low-Res Art→Low-Res Text→Low-Res Sketch→Low-Res

R@1 R@5 R@1 R@5 R@1 R@5 R@1 R@5

1 CLIP∗ 79.3 97.2 53.0 89.2 46.0 82.3 59.5 92.4

2 BLIP∗ 89.0 40.8 73.9 87.0 51.5 84.4 51.4 82.3

3 VPT 75.5 95.7 56.7 90.3 45.6 85.7 61.9 91.6

4 ImageBind 59.9 83.1 25.2 49.8 42.4 73.8 30.7 56.8

5 LanguageBind 81.0 97.6 47.3 81.2 58.5 87.9 55.5 85.6

6 FreestyleRet-CLIP 80.2 97.5 62.6 95.2 68.7 96.6 67.4 95.3
7 FreestyleRet-BLIP 88.4 98.6 63.9 94.1 76.0 97.5 71.3 94.3

Table 9. The Low-Resolution Image Retrieval performance of our FreestyleRet and baseline models.

but also achieves good performance when retrieving from
composed queries with various styles (sketch+text, art+text,
low resolution+text).

8.2. User Generalized Image Retrieval

Introduction: The User Generalized Image Retrieval
(UGIR) [41] is a task that retrieves natural images and text.
Formally, UGIR defines data belonging to one user as a user
domain, and the differences among different user domains
as user domain shift. UGIR trains on a user domain and
tests on various user domains to evaluate their feature gen-
eralization.

Difference: The user-generalized image retrieval task fo-
cuses on exploring the domain adaptation capability of re-
trieval models, where the domain refers to a natural image
dataset encompassing diverse categories of objects. How-
ever, in our style-diversified retrieval setting, we adapt the
domain of a wide range of image styles as queries, including
natural images, sketches, artistic images, and blurry low-
resolution images.

8.3. Fashion, Synthesis, and Sketch Retrieval

Introduction: Fashion Retrieval [17, 19, 47], Synthesis Im-
age Retrieval [48, 52, 60], and Sketch Retrieval [44] aim

to retrieve from one specific class of images, including the
fashion clothes, synthesis natural scenes, and sketch-based
images. These tasks are applied in the search engines.

Difference: The fashion retrieval, synthesis retrieval, and
sketch retrieval all focus on retrieving from single-style
queries. However, our style-diversified retrieval maintains
the ability to retrieve based on queries with various styles,
including sketch images and synthesis art-style images.

9. Supplements for Case Study
As shown in Fig. 8 and Fig. 9, we add more visualization
results in our supplementary material. Each sample
has three images to compare the retrieval performance
between our FreestyleRet and the CLIP baseline on the
DSR dataset. The left images are the queries randomly
selected from different styles. The middle and the right
images are the retrieval results of our FreestyleRet-
BLIP model and the original BLIP model, respectively.
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